
ISIM Interface™ 
  

 

 User’s Manual 
 Release 1.4 

June 22, 2007 
 Website: https://simtk.org/home/isim_interface 

 





 

 

 

 

 

 

 

 

 

Copyright and Permission Notice 
 
Portions copyright (c) 2006 Christopher M. Bruns and Stanford University 
Contributors: Mark Engelhardt, Mark Friederichs, Jeanette Schmidt, Paul Mitiguy, Blanca 
Pineda 
 
Permission is hereby granted, free of charge, to any person obtaining a copy of this document 
(the "Document"), to deal in the Document without restriction, including without limitation the 
rights to use, copy, modify, merge, publish, distribute, sublicense, and/or sell copies of the 
Document, and to permit persons to whom the Document is furnished to do so, subject to the 
following conditions: 
 
This copyright and permission notice shall be included in all copies or substantial portions of 
the Document. 
 
THE DOCUMENT IS PROVIDED "AS IS", WITHOUT WARRANTY OF ANY KIND, EXPRESS 
OR IMPLIED, INCLUDING BUT NOT LIMITED TO THE WARRANTIES OF 
MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE AND NONINFRINGEMENT.  
IN NO EVENT SHALL THE AUTHORS, CONTRIBUTORS OR COPYRIGHT HOLDERS BE 
LIABLE FOR ANY CLAIM, DAMAGES OR OTHER LIABILITY, WHETHER IN AN ACTION OF 
CONTRACT, TORT OR OTHERWISE, ARISING FROM, OUT OF OR IN CONNECTION WITH 
THE DOCUMENT OR THE USE OR OTHER DEALINGS IN THE DOCUMENT 
 
 

 i 



 

Table of Contents: 
Table of Contents:.............................................................................................................................. ii 

Introduction ....................................................................................................................................1 
General Information ...................................................................................................................1 
The Poisson-Boltzmann equation...............................................................................................1 
Task Flow In ISIM...................................................................................................................... 2 
System Requirements ................................................................................................................ 2 

Tutorial ........................................................................................................................................... 3 
Start the program ....................................................................................................................... 3 
Choose a molecule...................................................................................................................... 5 
Choose ion conditions ................................................................................................................ 6 
Simulation Parameters ..............................................................................................................8 
Ion Simulation............................................................................................................................ 9 
View Results ............................................................................................................................. 10 

Troubleshooting ............................................................................................................................13 
General Troubleshooting ..........................................................................................................13 
Why am I not getting the latest version of Ion Simulator Interface using webstart?............ 14 

Submitting Problem Reports and Enhancement Requests.............................................................17 
License...........................................................................................................................................17 

Ion Simulator Interface License ...............................................................................................17 
ABPS license ............................................................................................................................. 18 
ISIM License.............................................................................................................................20 

References .................................................................................................................................... 21 
APBS ......................................................................................................................................... 21 
ISIM .......................................................................................................................................... 21 

 

 ii 



Introduction 

This document is a work in progress. 

General Information 

Ion Simulator Interface is a graphical user interface to the programs ISIM and APBS, for 

computing the electrostatic potential in the vicinity of a macroion (macromolecule) in the 

presence of mobile dissolved ions. 

 

Documentation and source code for the programs APBS and ISIM can be found on the web at 

http://apbs.sourceforge.net/ and at http://mccammon.ucsd.edu/isim/, respectively.  See the 

License section of this document for information about use, duplication, and distribution of this 

software. 

The Poisson-Boltzmann equation 

The Poisson-Boltzman equation is important in the theory of electrostatic potential. 

Equation 1: Poisson’s equation, relating the charge density to the electrostatic 

potential and to the dielectric. 
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Equation 2: Poisson-Boltzmann equation, relating charge density to ion 

concentrations. 
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r: a position in space 

ρ(r): charge density at position r 

ρmacro(r): charge density of a fixed macroion 

qi: the charge on ion type i 

ni: the bulk concentration of ion type i 

φ(r): the electrostatic potential at position r 

ε(r): the dielectric at position r 

T: temperature (degrees Kelvin) 

k: Boltzmann’s constant 
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Task Flow In ISIM 

 

Figure 1: ISIM data flow 

 

System Requirements 

• The Ion Simulator Interface runs the programs ISIM and APBS on your local computer, 

so you will need to have adequate memory and other resources for the simulation.  In 

general a larger molecule will require more memory. 

• Java 1.3 or later runtime environment installed on your computer (available from 

java.sun.com) 

 2 



Tutorial 

Start the program 

• Go to the https://simtk.org web site, type Isim under “Search Simtk.org” and click “Go”. 
 

 
Figure 2: https://simtk.org home page 

• Click on Ion Simulator Interface. 

 

Figure 3: Ion Simulator Interface link 
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• The Ion Simulator Interface page will come up. 

• Click on “Downloads” on the upper left side menu. 

• Then under “Download Links” on the right hand side, click on IsimInterface1.3.278.jnlp.    

 
Figure 4: Ion Simulator Interface download page 

 

• ISIM will begin to download automatically. 

• The initial window will come up. 

 

Figure 5: Ion Simulator Interface as it appears when first launched. 
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Choose a molecule 

• You must choose a molecule about which to compute the ionic environment. 

• Usually this molecule is RNA, DNA, or protein. 

• Press the "Choose Molecule" Button to load a macromolecular structure file. 

• The file can be either in Protein Data Bank (PDB) format, or in PQR format. 

• PQR format contains partial charge information for each atom, while PDB format does 

not. 

 

 

Figure 6: Click on "Choose Molecule..." to select a fixed macroion for the simulation. 

• The “Choose Molecule” window will come up. 

 

Figure 7: The Choose Molecule Source dialog window. 
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• Load the molecule: 

o Option 1: click on the Load file button to choose a molecule saved locally. 

o Option 2: enter the molecule ID (PDB ID) and click the Fetch button to load 

molecule from the PDB Web Site (requires internet connection).  A sample valid 

PDB ID (1GRZ) is provided for your convenience. 

• After this step is complete, a green check should appear next to the “Choose Molecule” 

button. 

Choose ion conditions 

Click the “Choose Ion Conditions” button. 

 

Figure 8: Click the "Choose ion conditions..." button to select ion type. 

• The “Choose Ions” window will come up. 

 

Figure 9: Choose Ions Window 

• Choose ion type from the first drop down menu. 
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• Choose concentration from the second drop down menu, or use the slide bar to change 

ion concentrations, (concentrations are specified in units of millimols per liter (mM)). 

 

  

Figure 10: Select ion conditions from the pull-down menus 

 

• You can add up to three ion types by clicking on the “Add New Ion” button. 

• You need to adjust the concentration so that the “Net Charge” (shown in magenta above 

the “Add New Ion button) is = 0 in order to continue onto the next step.  

 

Figure 11: To “Add New Ion” and Net charge should be = 0. 
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Figure 12: Ions and concentrations with Net charge 0 mM selected 

• Click on the “Finish” button, a green check will appear next to the “Choose Conditions” 

button. 

• NOTE – you must select all three ion types, because no parameters for conditions with 

less than three ions have been precomputed.  

Simulation Parameters 

Setting Simulation Parameters is optional, that is why you automatically see a green check on 

the “Set Simulation Parameters” button. 

 

Figure 13: Click on “Set Simulation Parameters” button (optional step) 
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• Click the “Set Simulations Parameters” button. 

• The “Simulation Parameter” window will come up, make changes as desired and click on 

“Done”. 

• HINT – For a short test run, set the number of Monte Carlo steps to a much lower 

number, such as 500 or 1000. 

 

Figure 14: “Simulation Parameters” Window 

Ion Simulation 

• Click the “Simulate Ions Isim” button to start the computation (completing this step 

takes minutes to a few hours depending on the parameters). 

• The program ISIM will now run. 

• The amount of time this step takes will depend upon the complexity of the simulation. 

• The elapsed time for this step is indicated to the left of the button. 

• A green check will appear when the step is complete. 

 

Figure 15: Elapsed time shown on the left side of the button. 
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Figure 16: Simulation complete. 

View Results 

• Click on the “View Results” button. 

 
Figure 17: Click on “View results” button 

 

• The “Ions Count” window will come up showing the various calculations for the ion types 

previously picked. 
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• The “Ions Count” window has additional buttons to provide more detail and information. 

 
Figure 18: Ion Counts Window with various results. 

 

• Save ions counts… button: 

Saves the results into a .csv file that should open in excel. 

• Simulation details… button: 

o This will give you the simulation details as shown in Figure 19. 

 

Figure 19: Simulation details 

 

• 3D Pymol View… button: 

o When you click on this button and do not have Pymol installed, you will get the 

window in Figure 20 and you will need to install Pymol. 
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Figure 20: Pymol not installed, instructions how to download 

 12 



Troubleshooting 

(error messages) 

Java Version 

Isim Interface requires Java version 1.5 to run.  Some users have reported trouble when using 

Java version 1.6.  If you experience problems with ISIM Interface and you have Java 1.6 

installed, first try clearing your Web Start cache (see sections below), then run ISIM Interface 

again.  If problems remain, consider installing Java 1.5 instead of Java 1.6. 

 

General Troubleshooting 

Some problems can be diagnosed by examining the log window, which records the progress of 

Ion Simulator Interface (see figure). 

 

Figure 21: Examine the run log to help identify problems with the simulation. 
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PC Instructions -- Why am I not getting the latest version of Ion Simulator 
Interface using webstart? 

Webstart is supposed to fetch the latest 

version of the program from the simtk 

server, but sometimes it does not update 

to the latest version.  In this situation, 

you can get the latest version the next 

time you run by clearing the webstart 

cache.  Run Java Web Start by itself by typing “javaws” at the command line, or by finding and 

clicking Java Web Start on your system. 
Figure 32: Command line window   

 

Figure 23: To force an update to the latest version of the program, run Java Web Start by itself, then 

remove the ISIM application and any Shared SimTK Java Classes from the application cache. 
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Figure 24: If the ISIM application is not shown in the Java Web Start Application Manager, you will be 

unable to remove just the ISIM application from the application cache.  In this case, clear the entire 

application cache using the Preferences menu. 

MAC Instructions -- Why am I not getting the latest version of Ion Simulator 
Interface using webstart? 

Webstart is supposed to fetch the latest version of the program from the simtk server, but sometimes it 

does not update to the latest version.  In this situation, you can get the latest version the next time you run 

by clearing the webstart cache.  Run Java Web Start by doing the following: 

• Find the “Utilities” folder by going to the “File” menu, click on “Find” and type “utilities” on the 

search area. 

• In the “Utilities” folder find the “Java” folder and expand it. 

• In the Java folder select the J2SE  folder. 

• Double Click on “Java Cache Viewer” to run the application. 
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• The Viewer will come up: 

 

Figure 25: To force an update to the latest version of the program, then remove the ISIM application and 

any Shared SimTK Java Classes from the application cache. 

 

 

Figure 26: If you cannot find the Isim application, you can clear all applications by running Java Web 

Start in Utilities > Java > Java Web Start and selecting Preferences from the top menu. 
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Submitting Problem Reports and Enhancement Requests 
If you observe a problem with the program, or if you would like to request a new behavior in 

future versions, please file a bug or feature report at SimTK.org. 

You can do this by selecting Help > Report a program Problem (bug) or Help > Request a new 

program feature directly from the application.  

 

You can also file a bug or report a feature by going to the Isim Interface project page 

(https://simtk.org/home/isim_interface), select Advanced > ”Features & Bugs” > ”Bugs” or 

“Features” > ”Submit New”, fill in the report and click “Submit”. 

 

Thank you for helping us to improve the program. 

 

 

 

License 

 

The Ion Simulator Interface software consists of distinct components, each with a different 

distribution license.  Use and redistribution of the Ion Simulator Interface software is subject to 

the conditions of all of these licenses. 

Ion Simulator Interface License 

The Java graphical user interface source code and binaries are distributed under the terms of an 

MIT-style license. 

 

Copyright © 2005-2006 Christopher M. Bruns and Stanford University. All rights reserved.  

Redistribution and use in source and binary forms, with or without modification, are permitted 

provided that the following conditions are met:  

- Redistributions of source code must retain the above copyright notice, this list of 
conditions and the following disclaimer.  

- Redistributions in binary form must reproduce the above copyright notice, this list of 
conditions and the following disclaimer in the documentation and/or other materials 
provided with the distribution.  
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- Neither the name of the Stanford University nor the names of its contributors may be 
used to endorse or promote products derived from this software without specific prior 
written permission.  

-  
 THIS SOFTWARE IS PROVIDED BY THE COPYRIGHT HOLDERS AND CONTRIBUTORS  

"AS IS" AND ANY EXPRESS OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED 

TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS  FOR A 

PARTICULAR PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE  COPYRIGHT 

OWNER OR CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, 

SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING,  BUT NOT 

LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES;  LOSS OF USE, 

DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER  CAUSED AND ON ANY 

THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT 

(INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF 

THIS SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.  

 

 

ABPS license 

 

APBS binaries are included as part of the Ion Simulator Interface distribution. 

Primary author: Nathan A. Baker (baker@biochem.wustl.edu) 
Department of Biochemistry and Molecular Biophysics 
Center for Computational Biology 
Washington University in St. Louis 
Additional contributing authors listed in the code documentation. 

Copyright (c) 2002-2005. Washington University in St. Louis. 
All Rights Reserved. 
Copyright (c) 1999-2002. The Regents of the University of California. 
Portions Copyright (c) 1995. Michael Holst. 

This program is free software; you can redistribute it and/or modify it under the terms of the 
GNU General Public License as published by the Free Software Foundation; either version 2 of 
the License, or (at your option) any later version.  
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This program is distributed in the hope that it will be useful, but WITHOUT ANY 
WARRANTY; without even the implied warranty of MERCHANTABILITY or FITNESS FOR 
A PARTICULAR PURPOSE. See the GNU General Public License for more details.  

You should have received a copy of the GNU General Public License along with this program; if 
not, write to the Free Software Foundation, Inc., 59 Temple Place, Suite 330, Boston, MA 
02111-1307 USA  
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ISIM License 

ISIM binaries are included as part of the Ion Simulator Interface distribution.  These ISIM 
binaries are distributed under the terms of the following license: 

Primary author:  

Andreas Vitalis 

(at that time in the) McCammon group 

Dept. of Chemistry and Biochemistry  

University of California, San Diego  

 

Maintained by:  

Nathan Baker 

Dept. of Biochemistry and Molecular Biophysics 

Washington University, St. Louis 

 

Copyright (c) 1999-2002. 

The Regents of the University of California (Regents). 

All Rights Reserved. 

Permission to use, copy, modify, and distribute this software and its documentation for 
educational, research, and not-for-profit purposes, without fee and without a signed licensing 
agreement, is hereby granted, provided that the above copyright notice, this paragraph and the 
following two paragraphs appear in all copies, modifications, and distributions.  

IN NO EVENT SHALL REGENTS BE LIABLE TO ANY PARTY FOR DIRECT, INDIRECT, 
SPECIAL, INCIDENTAL, OR CONSEQUENTIAL DAMAGES, INCLUDING LOST 
PROFITS, ARISING OUT OF THE USE OF THIS SOFTWARE AND ITS 
DOCUMENTATION, EVEN IF REGENTS HAS BEEN ADVISED OF THE POSSIBILITY 
OF SUCH DAMAGE.  

REGENTS SPECIFICALLY DISCLAIMS ANY WARRANTIES, INCLUDING, BUT NOT 
LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS 
FOR A PARTICULAR PURPOSE. THE SOFTWARE AND ACCOMPANYING 
DOCUMENTATION, IF ANY, PROVIDED HEREUNDER IS PROVIDED "AS IS". 
REGENTS HAS NO OBLIGATION TO PROVIDE MAINTENANCE, SUPPORT, UPDATES, 
ENHANCEMENTS, OR MODIFICATIONS.  
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